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CustomWorks II  
Beyond the Basics 

 
CustomWorks II is stand-alone editing software that gives you the power to edit, merge, color 
sort, and much more design manipulation options than ever before. It is also a platform for the 
Designer’s Gallery Toolpacks that allow you to get the maximum benefit of your Designer’s 
Gallery programs. 
 
When you open CustomWorks II for the first time, you will need to have your serial number 
handy so you can open the program and register your CustomWorks II software.  

 
The registration may be done with or without an internet connection, but must be done before 
your program can be upgraded or updated. 
 
You will immediately see that CustomWorks II has a little bit of a new look. Several new icons 

have been added to the Design Tools toolbar   and one new icon on the 

Edit Tools toolbar . A Navigator window has been added and floats above the workspace.  
 
CustomWorks II comes with a Library of 51 designs in the .BLF format. Don’t forget to install this 
Library when you install CustomWorks II or the CustomWorks II Upgrade. 
 

I.   Set Up the Workspace 
     A.   Navigator Window 

The Navigator window is a quick way to zoom in on an area 
of the design for better viewing and editing 
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 The window is on by default at start-up when CustomWorks II is opened 

 To move the window, place your cursor in the Title Bar beside Navigator and 
then click and drag the window to the desired location on your screen. 

 The window may be opened and closed by pressing Alt+W on your keyboard. 

 The window may be closed by clicking the X on the top right corner of the 
window.  

 The Navigator may also be turned on and/or off by selecting TOOL BARS and 
clicking beside Navigator on the drop-down menu. 

 Refer to page 55 in your manual for more options. 
 
1. Open a design. 

  a)    Click the Merge Design tool . 
  b)    When the Browser opens, click the + beside the C drive, the + beside   
         Designer’s Gallery, the + beside CustomWorks and inside the box  
         beside Free Designs. 
         c)    Select the scarecrow (fall.BLF) and click Open. 

 A red rectangle appears around the 
design in the Navigator window. 

2.  Navigate the design. 
      a)   Click and drag the slider in the Navigator to the 
               right. 

 The red rectangle becomes smaller 
and the design on the design page 
becomes larger. Note also that the 
zoom increases in the zoom 
window. 

 When the cursor is placed over the 
zoom rectangle, it becomes a hand. 

b) Click and drag the cursor (hand) to move the zoom box to different areas of 
the design. 

c) Close the Navigator window. 
 
 B. Positioning the Left Panels 

There are several different panels in CustomWorks II, including the Color Palette, the 
Sequence View, the Properties Panel, and the Studio panel. By default, when you first 
open the software, these panels will always be “docked” on the right side of your 
workspace. However, there are ways to move them around into different positions for 
better viewing. 
 
1. Floating will allow docked panels to be moved 
 anywhere on the workspace. 

 a)  Right click in the Studio panel’s title bar. 
 b)  Select floating from the pop-up menu. 
 c)  Click and drag the panel to the desired place 
      on your workspace. 
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2. Hide a panel. 
  a)   Right click in the Studio panel’s title bar. 
  b)   Select Hide from the pop-up menu or simply click on the X in the top right  
        corner of the panel. To show the panel again, go to the menu bar, click the  
        Tool Bars menu, and select the name of the panel that you wish to show. 
3. Dock a floating panel. 
  a)   Left-click the Color Palette’s title bar and drag it a short distance,         
         continuing to hold down the mouse button. 

    A set of arrow buttons will appear on the screen 
in the form of a cross. There are four tabs with 

shaded sides  plus a center tab. As soon as 
the cursor is over one of the four shaded tabs, 
that area of the workspace or panel will turn 
into a blue shaded area indicating where the panel will be docked. 

 
  b)    Place the cursor over the left tab and then 
         release the mouse button to dock the 
         panel. 
4. Tabs – The panels may also be set up as tabs. 
 Tabbing the panels will allow you to view the 
 panels in their full size, making the panels  easier to view, especially the Color 
 Palette and the Sequence View. If you will look closely at the center button, you will 
 see small tabs on the bottom edge. 
  a)    Click, drag, and drop the Sequence View title bar on the center tab button.  
  b)    Repeat for each of the other panels and watch the tab bar form along the  
         bottom of the panel area. 
 
  c)    Simply click on any tab to open the full panel. 
 

II. Program Preferences  
 Click the Program Preferences icon. 
 A. Formats tab 
  1. Recipe – As in the previous CustomWorks, the Recipe only works with Frames,  

  LetterWorks, QuiltWorks or designs that are actually created in the program. Select 
  your preferred fabric type and CustomWorks will change the underlay based on the 
  fabric type. Recipe does NOT work with stitch files or BLF files.  

 Open the Recipe box to select a recipe from the menu. 

 When a Recipe is selected from the Program Preferences it will remain active 
each time a new design page is opened or until the recipe is changed. 

 CustomWorks now provides some very useful information for stabilizer, 
needle, and thread selection when the Recipe is accessed through the File 
menu.  

 a) Click File and click New. 
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 b) Select Towel from the Recipe menu. 
 c) Use the scroll bar under Recipe description to access the information. 

 
 

 c) If you just want to read the information and not apply the Recipe, click  
  Cancel. 
 d) Click OK and a new design page will open with the settings for the selected  
  recipe. Recipe does NOT work with stitch files or BLF files. 

 When a Recipe is selected under the File menu, it is only active on 
the new page. If another new page is opened, the recipe reverts 
back to Normal.  

 Look at the Title Bar at the top of the page to view the recipe type. 
    

  2. Machine Format – Open the Program Preferences 

 VP3 format (Viking/Pfaff) has been added – Hoops, reading and writing 
 

3. Color match on loading  
 A machine formatted design opened in CustomWorks II will retain the thread palette 
 in which it was created unless color match on loading is checked. 
 If Color match is checked, the colors will be matched to whichever color palette is 
 selected in the color Palette panel so you can easily match the thread colors to your 
 brand of embroidery thread. 
 NOTE: This feature was added in the last update for CustomWorks (build 2109) 

  a)    Open a new page, click Merge design , select a stitch file (design), and  
   click Open. Make note of the embroidery thread palette. 
  b) Open Program Preferences, click in the Color match on loading   

   box  and click OK. 
  c) Select a different embroidery thread palette (Sulky Rayon). 
  d) Open a new page and open the same design. Note that the thread palette has 
   converted the colors to the newly selected thread palette. 
 
NOTE:  .BLf files will retain the original colors whether the box is checked or not. 
 
 
 
 

B. Input Formats tab 
 New formats have been added – Open the Program Preferences 

 Viking/Pfaff (VP3)  
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 Zip File (ZIP) - CW II will not only open a zipped file but will also open zipped 
folders. 
 

 C. Babylock – New tab added 
  All hoop sizes along with stitch count and color count limits for each hoop are listed 

here. This guide is especially good for machines with smaller embroidery fields such as 
the Sophia and Ellure. The information here will help prevent creating a design file that 
is too large for the machine with a smaller hoop to handle. However, the hoop size still 
will need to be set in the View Hoop menu. 

 
  1. Under the Babylock tab in Preferences, select the PES100mm x 100mm hoop and 

 click OK. Look at the Status bar (above the Start menu) and note that the size did 
 not change. 

  2. Open the View menu, click Select Hoop…., select the 100mm x 100mm hoop, click 
 Apply and OK. 

  3. Now let’s work in reverse: Open the View menu, click Select Hoop…., select the 
 200mm x 200mm hoop, click Apply and OK. 

 Open the Preferences and click the Babylock tab. Note that the hoop 
automatically selected the 200mm x 200mm hoop. 

 
 D. Catalog Path tab 
  If you have Studio Plus or Studio III installed on your computer you will have a Catalog  
  path tab in Preferences. When your Browser is open the Catalog tab will appear  
  alongside the Browse tab. This tab gives you a view of your design catalogs. 

 Click Merge design to open the Browser 
     
 
 
 
 
 
 
 
 
 
 

 Close the Browser 
 
 
 

III. File Menu  
 
 A.  New… 
  1. Click File and click New… from the drop down menu - Here you have the ability to  
   change the Recipe for a single Design page  
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  2. Select your fabric type under Recipe and scroll through the advisor for a wealth of 
information on stabilizers, needles, etc., to help you get the best possible stitched 
results for your  designs. Even the order numbers are listed for the recommended 
stabilizers. 

   A new design page will automatically open when New is selected from the File  
  menu or you may just click Cancel if you only want to look at the information. 

 When a Recipe is selected, it will show in the Title Bar as Style. 
NOTE: The Recipe only works with Frames, and the LetterWorks, and QuiltWorks toolpacks.

  
    

B. Read and Write 
 CustomWorks II has the ability to read and Write to several external memory devices: 

 Amazing Box Max 

 Little Max 

 CardWorks II 
C. Print Options 

 1. Open any design onto the workspace. 
     a) Select Print Preview from the drop down File menu or you may click the  

      Printer icon  on the tool bar. 

 New Feature – the Print Preview now opens on the Design page. 
 

2. Click Settings   
  New Feature - On the Print Settings the crosshair can be removed making it easy 

to print templates that may be used for iron on transfers. Just remember to mirror 
image the image before going to the print settings. Otherwise the image will be 
backwards for your iron-on transfer. 

 

 Uncheck the box beside Remove crosshair and click OK. 

 Click close to remove the Print Preview and return to the design page. 

            
 
 
 
 

IV. Design Decoration Tools 
 CustomWorks II has added four new Decoration Tools. We’ll explore each one separately. 
 A. Carousel 
  The Carousel tool adds a number of repeated small design elements in a circular  
  pattern on  the workspace. You may use one of the 30 preloaded designs that come  
  with Carousel or a selection from any formatted design. I can see how this tool   
  can be used to create some awesome quilt blocks. 
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  1. Under the View menu, select the 200mm x 200mm hoop and click OK. 

  2. Click the Carousel tool.  For the first 
    exercise, I’ll use one of the preloaded designs. To 
    view the preloaded designs, click on the name of  
    the first design and use the arrow keys on your  
    keyboard to scroll through the thumbnail designs. When you arrive at the design that 
    you want to use, click Apply and the design will appear in the design window. 
  3. Select rose1 and click Apply. 
 
    NOTE: To give you an understanding of the Carousel tool, I’m going to break down 
    the different elements of the tool. 
 
    a)  Circle Dimensions value  
      determines the size of the 
      circle that the small designs 
      are placed on, rather than 
      the overall size of the  
      design. 
 
      The design’s outer  
      dimensions will be displayed 
      as the output size in the  
      lower right corner of the  
      dialog box. You will need 
      to keep your hoop size in 
      mind when setting the 
      Output size. 
 

 You may uncheck Keep aspect ratio and type in different values in the 
Height and Width dimensions to create an oval. 

 
    NOTE: Each time you apply a change to any of the elements in Carousel, watch the 
       Output size change. Before you exit the Carousel dialog box, be sure to  
       check the Output size just in case you want to make changes. After you exit, 
       it’s too late! 
 

b)  Objects 

 Count – number of designs 

 Angle -  rotation angle of each individual design 

 Offset angle – rotates the entire group of designs as a whole object 
The number of times the design repeats is related directly to the angle between 
each design so this is why the angle will change when the count is changed or 
vise versa. 
 
1. Change the Angle to 90 and note that the count automatically changed to 4. 
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2. Click Apply and you can clearly see that the designs are positioned at 90º. 
3. Change the Offset angle to 45 and Apply. 
4. Change the Offset angle back to 90 and Apply. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

c) Design properties 

 Scale% - Scales the size of each individual segment. 

 Angle – Adjusts the orientation of the individual segments 

 Auto Rotate – Uncheck to arrange all of the segments at the same 
 angle (relative to the overall design) 

 Reflect – Will mirror image each individual segment. 

 Color Sort  - Automatically applies the Color Sort function to the design 
 when the stitches are generated. 

1.  Change the Scale% amount to 75 and click Apply. Note that the designs 
 are 3/4 of the original size. (Look at the Output size before and after you 
 apply the scaling.) 

2.  Change the Angle to 90 and Apply. 
3.  Uncheck Auto Rotate and Apply. 
 
 
 
 
 
 
 
 
 
 
 

1-2 3 

1-
2 

3 
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4. Check Auto Rotate and Apply. 
 
5. Change the Objects Count to 6 and Apply.  
 
   The designs are overlapping a little so we 

have some options. 

 Change the count 

 Change Circle Dimensions to increase 
the Output size  

 
Remember 

that I selected the 200mm x 200mm hoop and the Output size is smaller than 
the selected hoop. 

 
 

6. Change the Circle Dimension to 150 and 
 Apply. 

     Check the Output size  
 
 I think we have a winner!   But lets create another look. 

7. Click inside the Reflect box and Apply. Now the objects are reflected but 
 are too spread out, so we can add more objects to fill the area. 
8. Change the Count to 8 and Apply. Perfect! Is the Output size still ok? 
9. Click Ok to place the Carousel on your current design page. 

10.  Save your design. 

 
A-1 Carousel – Using a Formatted Design 
 1. Open a new page. 
 2. Open the rabbit2.blf from the CustomWorks II Free Designs. 

6 7 8 
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   (Path: (C) drive –Designer’s Gallery – CustomWorks – Free Designs – rabbit2.blf) 
 3.  Select All Items in the Sequence View. The file will need to be Ungrouped for this 

exercise. 

 Right click and select Ungroup from the pop-
up menu. 

4. Left click and drag a box around the carrot. 
5. Right click on the carrot and select Carousel from the 
  menu. 
6. Change the Circle Dimensions to 125 and Click Apply. 
7. Click Ok to return to the current design page and save  
  your design. 
 

B. Scatter 
 The Scatter tool takes a small design and randomly scatters the design about in a   

prescribed area in the design workspace. One of the 26 built-in elements may be used 
or you may use an existing embroidery design. The scatter feature is good for creating 
fabric textures for purses, pillows, etc. 

  
 1. Open a new page.  
 2. Select a hoop. I’ll use the same one, so just click on the hoop icon on the left toolbar. 

  3. Click the Scatter tool . For the first exercise, I’ll use one of the  
    preloaded designs. To view the preloaded designs, click on the name of the first 
    design in the preview window and then use the arrow keys on your keyboard to scroll 
    through the thumbnail designs. When you arrive at the design that you want to use, 
    click Apply and the design will appear in the design window. 
 
 
  4. Select one of the preloaded designs and click Apply. 

 If you don’t like the Scatter, click Apply again. Each time Apply is 
clicked, the designs are randomly re-scattered (kind of like a 
kaleidoscope) and the output size will change. 

 
a) The Template Size for Scatter does not 
 have an aspect ratio so the Height 
 does not change in relation to the Width. 
 The Template Size should be set for the 
 size of the embroidery hoop you will 
 be using to stitch the embroidery. 
   

This Template is set for the  
Ellisimo 8” x 8” hoop (200mm x 200mm) 
 

 
 Template Size may be changed when you get ready to go to the design  
 page so that the Output  size will better match your  hoop size.  
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 The Output size will change each time a change is applied in the Scatter Design 
 Dialog box. 

 
b) Design Properties 
 

 To better help understand the Min.Scale% and Max. Scale%; 
 

 1. Set both amounts to 100% and click Apply. Now all the designs are the same size 
  . 

  2. Set the Min. Scale% to 50, the Max. Scale% to 150, and click Apply. 
  (The Scatter tool will make the designs smaller or larger to best fill the space).  
  The maximum and minimum sizes are  expressed as a percentage of the   
   original size of the element. 

 
 
 
 
 

 

 Minimum Spacing – Sets the minimum amount of space between the 
designs.  

 1. Change the Min. spacing to 20mm and click Apply. – this action  
  results in less designs. 

        2.  Change the Min. spacing to 5mm and click Apply. – this action   
    results in more designs. 

 Auto Rotate - Auto rotate is checked by default. This 
allows the tool to rotate the design elements 
randomly within the Scatter .Uncheck the Auto 
Rotate box and click Apply to force the designs to 
all be placed with the same orientation. 

 Color Sort - Automatically applies the color sort 
function to the design when stitches are generated. 
This box is checked by default, but if you want the colors NOT to sort, 
uncheck the Color Sort box. 

 Click Ok to return to the current design page and save your design. 
 

B-1 Scatter using a formatted Design 
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 A small design (an inch or less) needs to be selected for the 
Scatter function. 

 1. Open a new page. 

 2. Click Merge Design , select the snowflakes .blf from 
CustomWorks II Free Designs, and click Open. 

3. In the Sequence View, delete everything except the first 
snowflake. 

 Right click on the remaining snowflake and select Scatter. 

 Proceed with any further changes desired. Click OK if you 
want to save the scatter or Cancel to return to the design 
page. 

4. Open a new page. 
5. Open the hearts design (wb14 .v6.pes). This design is  
     a free download from the amazingdesigns.com web site.  

  a) Click the Stitch tool . 

b) Click the Lasso Select tool beside the STOP tool. 
c) Click and drag a lasso around everything except the small heart on the bottom left. 
d) Touch your Delete key to delete the selected stitches. 
e) Click the Select tool. 
 f) In the Sequence View click All Items. 
g) Right click on the remaining heart in the workspace and select Scatter. 
   Proceed with any further changes in the Scatter dialog box. 
 
 

C. Adding Accents to a Design 
 The accent tool allows you to place individual crystals, pearls, nailheads, and sequins onto 

your embroidery design in the workspace. Using this tool, you can now preview how a 
design incorporating these features will look before the actual sew-out. You can even see 
the accents in the print preview of the design and from there print out a placement guide. 

 
 1. Open a new page. 

 2. Click Merge Design , select the butterfly (bali2.blf) from     
   CustomWorks II Carousel Designs, and click Open. 
 

 Click the Transform tab in Properties, change the 
width to 3” (75mm) and click Apply. 

 

3. Click the Accent tool and the Accents open in 
Properties. 

 
 
 
  The Accents may be viewed two different ways. 
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  a) Select the type of Accent from the Folder in properties and then open the Accent 
 menu to view a list of colors, shapes, and sizes for the chosen accent type. 

  b) Click Preview in the Properties and a window opens that will allow you to see a 
 pictures of the accents. 

 Open the Crystals and select one of the 4mm crystals. The cursor will turn into 

       a +. 
 Left click on each spot on the butterfly wings to place a crystal. 

 Open the drop down Accent window and select a 3mm crystal. 

 Click on each eye to place a crystal. 
 

4. In the Sequence View, select and delete the spots and 
the eyes that will otherwise stitch. 

 
 
 
 
 
 
 
5. Under File, click Print Preview. 
  The Print Preview now shows up on the design page. 

                  
 Click Print to print the template to use as an accent placement guide. 

 Click Close to close the print preview and return to the current design page. 
 

D. Frames and Accents 
 There are 115 shapes in CustomWorks II. The shapes may be 

used to create templates for the placement of Crystals and 
other Accents.  

 
 1. Open a new page. 

 2. Click the Frames Icon. . 

 Select a shape. (stocking) 

 Click inside the circle beside Accent. 

 Select Sequins from the Folder. 

 Select snowflake_red_6mm from the Accents folder. 

 Change the Length to 3mm and click OK. The Length 
is the spacing between the accents. 

        I wanted the sequins to overlap so I could stitch them on 
        my sewing machine. 

 If you are not pleased with the spacing, you may change the spacing by 
entering a new Length in the Properties (and/or also change the type of 
Accents). Change the length to 6mm and click Apply. 
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3. When you are satisfied with your template click Print Preview and print the template 
or just click Print from the drop-down File menu. 

 

E. Design on Path   
 Design on Path will repeat a small design on a selected path. You may select from  
 30 built-in designs in the Design on Path dialog box or select a small design of your 

choice from one of your collections. A path may be chosen from one of the 7 paths in 
the dialog box. If QuiltWorks is installed, you may create a new path and save it. 

 
 1. Open a new page. 

 2. Click the Design on Path tool . 
   The dialog opens with a default path 

  and design.  
   a) Path dimensions – the path  

    dimension is the height and  
    width of the line. The Output  
    size is the height and width the  
    design will be when it is saved to 
    the design page workspace  
    when you click OK.                  
This is where you will want to pay close 
attention to the Output size in relation to the hoop size that you will use to stitch your 
design. For example: look at the output size for the default design on path - 330.90mm 
wide x 85.3 mm tall. Your design would be too large for the largest hoop which is 
200mm x 300mm (Ellisimo/BMP). 

 If you really want to use a path larger that your hoop, you have the option to split it with 
Designer’s Gallery HoopWorks tool pack. 

 
     When Keep aspect ratio is checked, the height of the design on path will  

    change in relation to the width of the design on path line. To better understand  
    this: 

 Uncheck Keep aspect ratio.  
 

 Change the height to 0 and click Apply.  
   Now the Path is straight. 
    This is the perfect use of a design to create a border. You may even use the  
   border with the Continuous function built into your Baby Lock embroidery  
   machine along with the Continuous Border Hoop. 
 

 Make a note of the Output size -  When the width is 
changed in the path dimensions the size of the designs seem to change also, 
however the individual design size does not change at this point. To illustrate 
this, change the path width dimension to 200 and Apply (also remember at 
this point that the aspect ratio is still turned off). Again look at the output size 
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and see that the height (50mm) did not change  even 
though the designs look larger. 

 
  NOTE: The design size can be changed in this dialog box and I will cover a little 
          later when I discuss Properties. 

 Select the Circle 003 from the Path box  
 

 With the aspect ratio still unchecked, change either the height or width to 
100mm and click Apply. The height is ½ of the width and you have created an 
oval.  

   
       .  

 
     
   
 
 
 

 
   b)  Align 

 Select: path 001 – Design lacey3 – aspect ratio unchecked – height 0 –  
        width 200 and Apply. 

        
          TOP- places design on top of path. 
           

          Bottom- places design on bottom. 
 
 
          Reflect- mirrors the design from 

        top to bottom. 
 
 
          Alter- alternates every other  

                   design on top and bottom 
                   of the path. 

 Click Top. 
  c)  Properties 
    Length (mm) – changes the length of each individual design and the height will  

   change proportionally 
                        

 Change to each of the lengths 
on the illustration and Apply 
after each change. 
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       As the length decreases, more        designs appear on the design  
  path. 

 
      
    NOTE: If you are using a file that has already been turned into a stitch file, you must 

   have the SizeWorks tool pack installed to re-calculate the stitch count. If you are 
   using a BLF file SizeWorks is not necessary. 

 
     Spacing (mm) – Sets the amount of space between the designs. 

 Change the Spacing to 10mm and Apply. 
 
  Color Sort - The Color sort feature automatically applies the color sort function to 
  the design when stitches are generated. This box is checked by default, but if you 
  want the colors NOT to sort, uncheck the Color Sort box. 
 

 Click OK to place the Design on a Path in your current design page. 
 
 

 
3.  Create and Save New Path 
  If you have QuiltWorks II installed as a toolpack, it is possible to create and save a 
  new path. If you have MasterWorks, you may also create new paths and save them 
  in the CustomWorks Library for Design on Path. 
 
  a)  Open a new page. 

  b) Click on the Pencil tool  on the QuiltWorks II toolbar and then select one of 

   the line drawing tools .  

 Draw a new path or shape on the workspace.  

 Select the path. 

 Right click on the new path and select  
        Export to library from the menu. 
        When the Design dialog opens, give the path a name 
        (i.e. fg shape) and click Save.            PATH -- 

 Open   to view the new path.                                                                           
          

4.  Random Design for Design on Path 
  Any design (stitch file or blf file) may be used as a Design on Path. Very small  
  designs (¼ “– ¾”work really well). 
  a)  Open a new page. 

    b)   Open the rabbit2.blf from the CustomWorks II Free Designs. 
            (Path: (C) drive –Designer’s Gallery – CustomWorks – Free Designs – 
                     rabbit2.blf) 
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    c) Select All Items in the Sequence View. Since this file is Grouped, it will 
need to be Ungrouped for this exercise. 

 Right click and select Ungroup from the pop-up menu. 
   d) Left click and drag a box around the carrot. 

     In Properties click the Transform tab, Rotate 270º, and click Apply. 
   e) Right click on the carrot and select Design on Path from the menu. 
   f) Change the Width to 200mm, Length to 30mm, Spacing to 5mm, and  
    Apply. 
   g) Click Ok to return to the current design page and save your design. 

 
 NOTE: CustomWorks uses a lot of the Resources in your computer especially if you 

       have all of the Toolpacks installed. Due to this, you may need to close some 
       of the Design pages if you are finished with them. This has been made more 
       efficient in CustomWorks II. 

 Whenever you click on a Design tab an x  
 appears beside the design page number. Simply click on the X to  
 close the selected design page. 

 V.  Place and Stitch  
  Embroidering is easy but sometimes placement can be a little tricky. The Place & Stitch 

feature will help you with accurate design placement on garments and other projects. You 
can see how your embroidery design will look without having to sew it out. This can be 
accomplished in five easy steps.  

  A. Click the Place and Stitch tool  and 
  select from 71 design templates. 

 Use the arrow keys on your 
keyboard to scroll through the 
designs 

1.  Select cuff2 from the Garment 
menu. 

    The size may be changed to  
    match the size of your project. 

    Click Ok 

    Click the Transform tab in  
    Properties, enter 270 in the Rotate box and Apply.  

    2.  Click Merge Design and select your design of choice. I will use one of the Nancy 
    Zieman designs from the Ellisimo embroidery machine. 

  a) Position the embroidery on the desired area of the template. 

 You can also make a print-out of the garment template with the 
designs by clicking Print Preview, and then clicking on Print. 

 Turn on the hoop that you 
want to use to make sure 
everything fits in the hoop. 

b) Save the design as a stitch file. 
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3.  Stitch the design onto a piece of hooped stabilizer. 
 
4.  Using the stitched outline as a guide, position the shirt cuff on the stabilizer and 

secure the cuff to the stabilizer. 
 
5.  Embroider the Design. 

 
  B. Another idea for Place and Stitch is to use the templates as patterns for projects. Some 

  could probably be used for “in the hoop projects”. 
 
    1.   Open a new page. 

    2.  Click  and select Dishtoweltop1 from the Garment menu. 

 Uncheck Maintain aspect ratio and change the  
   Height to 4” (100mm) x Width to 6” (150mm) and click OK. 

     3.  Select the template and then right click to Copy and Paste the template. 

 In Properties, click the Transform tab, change 
the Width to 5” (127mm), and click Apply. 

 Click Center Align  on the top tool bar. This 
action will produce a seam allowance and the 
area for the design placement. Before the design 
page is saved, the copied template will be 
deleted (its only purpose is visual). 

4.  Merge the design of your choice. I will use the 
  holly.blf from the CustomWorks II free designs.  

 With the design selected, click the Center align tool . This will place the 
design in the center of the template. Since it is a .blf design, it may be resized 
to fit the area if necessary. 

5.  Select the inside template and touch Delete on your keyboard. 
6.  Save the design as a stitch file. 
7.  Hoop the stabilizer and the fabric you will use for your project. The line that 

stitches for the template will be the cutting line. 
    

    NOTE:  The Place and Stitch product by Nancy Zieman and Amazing Designs includes 
        over 400 pattern stitch outlines. To learn more about how to use Place and 
      Stitch visit www.amazingdesigns.com. 

     If you have purchased one of the Place and Stitch products, you may add the 
   templates to your CustomWorks II library. 

   

VI. More New Stuff  
 A. Motif Stitch Setting Adjustments 
  Aside from the pattern, there are a number of other settings that you can adjust that are 

particular to the Motif Run segment type. The Motif Stitch Settings are best understood 
when applied to a straight line.  

 

http://www.amazingdesigns.com/
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1. If you have QuiltWorks installed as a tool pack, click the pencil tool and then select 
one of the drawing tools and draw a straight line. Right click on the line and select 
Convert to Run or…………………… 

2. If QuiltWorks is not installed we can create a straight line; 

 Open the Frames  and select the rectangle from the Shapes. 

 Click inside the circle beside Run and click OK. 

 Click the Reform tool on the edit tool bar. 

 Right click on each of the blue edit squares (one at a time) and select Split line 
from the menu.  

 Delete the bottom and side lines. (now you have a straight line) 

 Select the line. 
  2. In the Run profile in Properties open the Run type menu and select Motif f081. 

 Change the Stitch length to 7mm (the stitch length is the size of the motif). 

 Click Apply 
3. Run length profile: You can modify how the stitch length varies along the Motif run 

by choosing a different Run length profile (Linear increasing, Linear decreasing, 
convex or concave) Select each setting and apply to see the differences. 

 
 Suggestion: Use the undo and redo buttons to alternate and compare the changes.  
 

  None: The length of the Run stitches will be consistent throughout the path. The 

         Run stitch will not have a varying stitch length.  

 

  Linear Increasing: The stitch length will start at the value defined in the Minimum 
Stitch Length (1.5) box and will increase to the value defined in the Stitch 

    length box.  Change the Minimum Stitch Length to 3mm. 

     and apply to see the effect.  (MSL 3mm) 
 

  Linear Decreasing: The stitch length will start at the value defined as the Stitch 

Length and will decrease to the value given in the 
Minimum Stitch length box. 

 

   Convex: The Convex setting will produce a Run stitch where the stitch length is    

longest at the middle of the path and shortest at the ends.  
 

   Concave: The Concave setting will produce a Run stitch where the stitch length is   

shortest at the middle of the path and longest at the ends.  
 

   Change the setting back to None and Apply. 
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.  

 4.  Run Spacing: You can also change the spacing between the motifs, in order to  
  change the density of stitches in the segment. 

 Set the Run Spacing to 5 and Apply.  
 

 5.  H-Arrange and V-Arrange: With the Horizontal-Arrange and Vertical-Arrange  
  settings, you can create new programmed run patterns, by rearranging the   
  arrangement of the motifs in existing patterns. The Motif run segment can be flipped 

horizontally or vertically You can also choose Alternate, which flips only every other       
motif in the segment. 

       

 

  Note: If  you are using motif stitch in a frame, some motif types will work better than   
 others; you should not expect to get good results for all combinations of motif type 
 and stitch length. 

 

  B.   Power Copy 
 Power Copy has been added to CustomWorks II and allows you to copy, rotate, and            
 resize an artwork segment all in one step. 
 
 1.  Open a new page.  
 2. Open any design on the workspace. (I’ll select the bee from   
  CustomWorks II Free  Designs) 

 Right click on the design. 

 Select Power Copy from the menu. 
3. Left click anywhere on the workspace and a copy of the design or the design 

segment will be pasted on the one the workspace or left click and drag for a different 
size and angle. 

 
C. Color Palette 
 A specific color can be quickly located with the new Find Color feature. 
 1. In the Sequence View, click on the 4th color 
    (outline for the bee’s wings) 
 
 2. Open any color palette. (I’ll use Robison Anton 

  Poly) 
 
 3.  Click on the? and a Find Color box opens.  
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 Type b in the box and a list of all colors beginning with the letter b appear in the 
menu. 

 Select blue ink and click Find. 
 
 
 
 
 

 Click the color chip and it will change the name of the color in the 
     Sequence View and on the design. 

 

 
 
 This concludes today’s session of CustomWorks II Beyond the Basics. Have fun with   
 the new features and create some really awesome projects.  
 


